# Table of Contents

**EasyVR Module** .................................................................................................................. 4  
  Product Description .................................................................................................................. 4  
  EasyVR features ....................................................................................................................... 4  

**Technical specifications** .......................................................................................................... 5  
  Physical dimensions and pin assignment .................................................................................... 5  
  Recommended Operating Conditions ......................................................................................... 6  
  Electrical Characteristics .......................................................................................................... 6  
  Power Supply Requirements ....................................................................................................... 6  
  Serial Interface .......................................................................................................................... 6  
  Microphone ................................................................................................................................. 7  
  Audio Output ............................................................................................................................... 8  
  General Purpose I/O .................................................................................................................... 8  
  Flash Update ............................................................................................................................... 10  

**Quick start for using the module** ............................................................................................. 11  
  EasyVR on Arduino ................................................................................................................... 11  
  EasyVR on Robonova ................................................................................................................. 14  
  EasyVR on Basic Stamp ............................................................................................................. 15  

**EasyVR Shield for Arduino** ...................................................................................................... 16  
  Technical specifications .............................................................................................................. 16  
  Physical dimensions and pin assignment ................................................................................... 16  
  Jumper settings ......................................................................................................................... 17  
  LEDs .......................................................................................................................................... 17  

**Quick start for using the Shield** ............................................................................................... 17  

**EasyVR Programming** ............................................................................................................ 19  
  Communication Protocol .......................................................................................................... 19  
    Introduction .............................................................................................................................. 19  
    Arguments Mapping ............................................................................................................... 20  
    Command Details .................................................................................................................... 21  
    Status Details .......................................................................................................................... 25  

**Communication Examples** ..................................................................................................... 27  
  Recommended wake up procedure ............................................................................................. 27  
  Recommended setup procedure .................................................................................................. 27  
  Recognition of a built-in S1 command ....................................................................................... 28  
  Adding a new SD command ....................................................................................................... 28  
  Training an SD command .......................................................................................................... 29  
  Recognition of an SD command ............................................................................................... 29  
  Read used command groups ..................................................................................................... 30  
  Read how many commands in a group ..................................................................................... 30  
  Read a user defined command ................................................................................................. 30  
  Use general purpose I/O pins .................................................................................................... 31  
  Use custom sound playback ...................................................................................................... 31  
  Read sound table ....................................................................................................................... 31  

**Built-in Command Sets** .......................................................................................................... 32  

**Error codes** ............................................................................................................................ 33  

**Protocol header file** .............................................................................................................. 34
EasyVR Module

Product Description

EasyVR is a multi-purpose speech recognition module designed to easily add versatile, robust and cost effective speech recognition capabilities to virtually any application. The EasyVR module can be used with any host with an UART interface powered at 3.3V – 5V, such as PIC and Arduino boards. Some application examples include home automation, such as voice controlled light switches, locks or beds, or adding “hearing” to the most popular robots on the market.

EasyVR features

- A host of built-in Speaker Independent (SI) commands for ready to run basic controls, in the followings languages:
  - English (US)
  - Italian
  - German
  - French
  - Spanish
  - Japanese
- Supports up to 32 user-defined Speaker Dependent (SD) triggers or commands as well as Voice Passwords. SD custom commands can be spoken in ANY language.
- Easy-to-use and simple Graphical User Interface to program Voice Commands and audio.
- Module can be used with any host with an UART interface (powered at 3.3V - 5V)
- Simple and robust documented serial protocol to access and program through the host board
- 3 GPIO lines (IO1, IO2, IO3) that can be controlled by new protocol commands.
- PWM audio output that supports 8Ω speakers.
- Sound playback of up to 9 minutes of recorded sounds or speech.
Technical specifications

Physical dimensions and pin assignment

<table>
<thead>
<tr>
<th>Connector</th>
<th>Number</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1</td>
<td>1</td>
<td>GND</td>
<td>-</td>
<td>Ground</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>VCC</td>
<td>I</td>
<td>Voltage DC input</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>ERX</td>
<td>I</td>
<td>Serial Data Receive (TTL level)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>ETX</td>
<td>O</td>
<td>Serial Data Transmit (TTL level)</td>
</tr>
<tr>
<td>J2</td>
<td>1-2</td>
<td>PWM</td>
<td>O</td>
<td>Differential audio output (can directly drive 8Ω speaker)</td>
</tr>
<tr>
<td>J3</td>
<td>1</td>
<td>MIC_RET</td>
<td>-</td>
<td>Microphone reference ground</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>MIC_IN</td>
<td>I</td>
<td>Microphone input signal</td>
</tr>
<tr>
<td>J4</td>
<td>1</td>
<td>/RST</td>
<td>I</td>
<td>Active low asynchronous reset (internal 100K pull-up)</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>/XM</td>
<td>I</td>
<td>Boot select (internal 1K pull-down)</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>IO1</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>IO2</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>IO3</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
</tbody>
</table>

**Note:** the GPIO (J4.3, J4.4, and J4.5) are at nominal 3.0VDC level. Do not connect 5VDC directly to these pins!
Recommended Operating Conditions

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCC</td>
<td>Voltage DC Input</td>
<td>3.3</td>
<td>5.0</td>
<td>5.5</td>
<td>V</td>
</tr>
<tr>
<td>Ta</td>
<td>Ambient Operating Temperature Range</td>
<td>0</td>
<td>25</td>
<td>70</td>
<td>°C</td>
</tr>
<tr>
<td>ERX</td>
<td>Serial Port Receive Data</td>
<td>0</td>
<td>-</td>
<td>VCC</td>
<td>V</td>
</tr>
<tr>
<td>ETX</td>
<td>Serial Port Transmit Data</td>
<td>0</td>
<td>-</td>
<td>VCC</td>
<td>V</td>
</tr>
</tbody>
</table>

Electrical Characteristics

These are applicable to J4 pins only, including IO1-3, /XM and /RST.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIH</td>
<td>Input High Voltage</td>
<td>2.4</td>
<td>3.0</td>
<td>3.3</td>
<td>V</td>
</tr>
<tr>
<td>VIL</td>
<td>Input Low Voltage</td>
<td>-0.1</td>
<td>0.0</td>
<td>0.75</td>
<td>V</td>
</tr>
<tr>
<td>IL</td>
<td>Input Leakage Current (0 &lt; V_ID &lt; 3V, Hi-Z Input)</td>
<td>&lt;1</td>
<td>10</td>
<td>µA</td>
<td></td>
</tr>
<tr>
<td>RPU</td>
<td>Pull-up Resistance</td>
<td>Strong: 10</td>
<td></td>
<td>kΩ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Weak: 200</td>
<td></td>
<td>kΩ</td>
<td></td>
</tr>
<tr>
<td>VOH</td>
<td>Output High Voltage (I_DH = -5 mA)</td>
<td>2.4</td>
<td></td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>VOL</td>
<td>Output Low Voltage (I_DL = 8 mA)</td>
<td>0.6</td>
<td></td>
<td>V</td>
<td></td>
</tr>
</tbody>
</table>

Power Supply Requirements

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISleep</td>
<td>Sleep current</td>
<td>&lt; 1</td>
<td></td>
<td>mA</td>
<td></td>
</tr>
<tr>
<td>IOper</td>
<td>Operating current</td>
<td>12</td>
<td></td>
<td>mA</td>
<td></td>
</tr>
<tr>
<td>ISpeaker</td>
<td>Audio playback current (with 8Ω speaker)</td>
<td>180</td>
<td></td>
<td>mA_(RMS)</td>
<td></td>
</tr>
</tbody>
</table>

Serial Interface

The EasyVR is a “slave” module communicating via an asynchronous serial interface (commonly known as UART interface), with the following features:
- Baud Rate: 9600 (default), 19200, 38700, 57600, 115200
- Frame: 8 Data bits, No parity, 1 Stop bit

The receiver input data line is ERX, while the transmitter output data line is ETX. No handshake lines are used.

Example of a serial data frame representing character “A” (decimal 65 or hexadecimal 41):

```
VCC
Idle       Start  1  0  0  0  0  0  1  0  Stop  Idle
0V
```

See also chapter Communication Protocol later on this manual for communication details.
Microphone

The microphone provided with the EasyVR module is an omnidirectional electret condenser microphone (Horn EM9745P-382):

- Sensitivity -38dB (0dB=1V/Pa @1KHz)
- Load Impedance 2.2K
- Operating Voltage 3V
- Almost flat frequency response in range 100Hz – 20kHz

If you use a microphone with different specifications the recognition accuracy may be adversely affected. No other kind of microphone is supported by the EasyVR.

Note: Vocal commands should be given from about 60cm from the microphone, but you can try at greater distances by talking louder.

Please note that improper acoustic positioning of the microphone will reduce recognition accuracy. Many mechanical arrangements are possible for the microphone element, and some will work better than others. When mounting the microphone in the final device, keep in mind the following guidelines:

1. **Flush Mounting** - The microphone element should be positioned as close to the mounting surface as possible and should be fully seated in the plastic housing. There must be no airspace between the microphone element and the housing. Having such airspace can lead to acoustic resonance, which can reduce recognition accuracy.

![GOOD - BAD](image)

2. **No Obstructions, Large Hole** - The area in front of the microphone element must be kept clear of obstructions to avoid interference with recognition. The diameter of the hole in the housing in front of the microphone should be at least 5 mm. Any necessary plastic surface in front of the microphone should be as thin as possible, being no more than 0.7 mm, if possible.

![clear area - internal diaphragm](image)

3. **Insulation** - The microphone should be acoustically isolated from the housing if possible. This can be accomplished by surrounding the microphone element with a spongy material such as rubber or foam. The provided microphone has this kind of insulating foam. The purpose is to prevent auditory noises produced by handling or jarring the device from being “picked up” by the microphone. Such extraneous noises can reduce recognition accuracy.
4. **Distance** - If the microphone is moved from 15 cm to 30 cm from the speaker's mouth, the signal power decreases by a factor of four. The difference between a loud and a soft voice can also be more than a factor of four. Although the internal preamplifier of the EasyVR compensates for a wide dynamic range of input signal strength, if its range is exceeded, the user application can provide feedback to the speaker about the voice volume (see appendix [Error codes](#)).

**Audio Output**

The EasyVR audio output interface is capable of directly driving an 8Ω speaker. It could also be connected to an external audio amplifier to drive lower impedance loudspeakers.

**Note:** Connecting speakers with lower impedance directly to the module may permanently damage the EasyVR audio output or the whole module.

It is possible to connect higher impedance loads such as headphones, provided that you scale down the output power according to the speaker ratings, for example using a series resistor. The exact resistor value depends on the headphone power ratings and the desired output volume (usually in the order of 10kΩ).

**Note:** Connecting headphone speakers directly to the EasyVR audio output may damage your hearing.

**General Purpose I/O**

Since the EasyVR communication interface takes two pins of the host controller, a few spare I/O pins are provided, that can be controlled with the communication protocol, to get those pins back for basic tasks, such as lighting an LED.

The three I/O pins IO1–IO3 are connected directly to the embedded microcontroller on the EasyVR module, so they are referenced to the internal 3.0V regulated power supply. If you need to interface to circuits using a different supply, there are a number of solutions you can adopt. Some of these are outlined below (here IOn indicates any one of the three I/O pins of the EasyVR).

**Use a pin as an output**

All the I/O pins are inputs with weak internal pull-up after power on. You must explicitly configure a pin before you can use it as an output (see the example code [Use general purpose I/O pins](#)).
I/O pin directly driving a low-current LED  

I/O pin connected to high impedance 5V circuit (such as MCU input pin)  

I/O pin switching a load on a high voltage line using a 12V relay

The exact components values in these circuits may vary. You need to calculate required values for your application and choice of components. For example, resistor value for the LED circuit can be calculated approximately as:

$$R_{LED} = \frac{V_{OH} - V_{LED}}{I_{OH}}$$

Where $V_{LED}$ is the LED forward voltage, as reported on the LED datasheet, at the driving current $I_{OH}$ (see section Electrical Characteristics). Let's assume a typical low-current LED has a $V_F=1.8V$ at 5mA, the resistor value is:

$$R_{LED} = \frac{2.4 - 1.8}{0.005} = 120 \, \text{Ohm}$$

Now stay on the safe side and choose a slightly larger resistor, such as 150Ω.

If you want to drive higher current LEDs, you need a circuit like the second one, where you put the LED between the output resistor and the collector of the NPN transistor.

**Use a pin as an input**

All the I/O pins are inputs with weak internal pull-up after power on or reset. You may also configure the pin to have a strong pull-up or no pull-up at all (see the example code Use general purpose I/O pins).

I/O pin connected to a switch (or switching sensor)  

I/O pin connected 5V source (such as MCU output pin)  

I/O pin with isolated input (for safety circuits)

All these circuits assume the EasyVR pin has been configured with an internal pull-up (passive components value can be adjusted to account for weak or strong pull-up).

Disabling the internal pull-up could be used to put the pin in high-impedance state, for example to simulate a tri-state or open-drain output port.
Again, you should refer to the manufacturer’s datasheet when interfacing any external components and to calculate required resistors values or other passive components.

**Flash Update**

The EasyVR module includes a bootloader that allows to update the firmware and to download new sound tables to the on-board memory.

The *boot mode* is activated by keeping the /XM signal to a high logical level at power on or reset. This can be easily done with a jumper (or switch) taking the signal to a suitable pull-up resistor.

To download a firmware update or a sound table to the EasyVR, power on the module with the jumper closed. For normal operation, just leave the jumper open. Do not change the jumper position while the module is already powered on. It is safe to change /XM level while the module is reset (/RST low).

![Boot mode selection circuit](image)

The pull-up resistor value to use depends on the VCC power supply voltage. For the voltage of the /XM pin when the jumper is closed (short) the following relation holds (note you have a voltage divider circuit):

\[
V_{XM} = \frac{1K}{R + 1K} V_{CC}
\]

Now if you want /XM to be at 3V (logic high) and solving for \( R \), you get:

\[
R_{pu} = \frac{V_{CC}}{3} \cdot 1000 - 1000
\]

That makes 100Ω for 3.3V and around 680Ω for 5V power supplies. Other kinds of circuit are possible, that is just an example and one of the simplest to realize.

To learn how to download new sound tables to your EasyVR module, have a look at the section *Using Sound Table*. 
Quick start for using the module

EasyVR on Arduino

You can connect the EasyVR module to an Arduino board basically in two ways:

1. **Bridge mode** – You can control the module using a software serial library and connect to the module with the EasyVR Commander from your PC, with the same pin configuration

2. **Adapter mode** – You can use the Arduino board as a USB/Serial adapter by holding the microcontroller in reset, but you need to change the connections once you want to control the module from the microcontroller

**Bridge mode**

This is the preferred connection mode, since it allows simple communication with both the Arduino microcontroller and the PC. All the provided examples for Arduino manage the bridge mode automatically when the EasyVR Commander requests a connection.

Automatic bridge mode used to be supported only on Arduino boards with a bootloader implementing EEPROM programming.

The latest version of EasyVR Commander (since 3.1.x) and Arduino libraries (since 1.1) does not rely on that feature anymore, so it should work on all Arduino boards.

**Note:** bridge mode cannot be used to download a Sound Table or to perform a flash update. You need to use adapter mode or a true USB/Serial adapter.

**Adapter mode**

This connection scheme has the advantage of working with any Arduino board that has an on-board USB/Serial adapter and not needing a spare input pin to enter bridge mode.

Also, it does not rely on the AVR microcontroller to do any software bridge between communication pins, so it can be used to check your hardware in case of connection problems.

Using this method also allows you to download a Sound Table to the EasyVR module, provided you also configure the module to start in boot mode (see paragraph [Flash Update](#)).
This configuration, with Reset shorted to GND, is for connection with the EasyVR Commander. To use the module from the Arduino microcontroller, you need to remove the short (yellow wire) and move the ETX/ERX connection to other pins. The example code uses pin 12 for ETX and pin 13 for ERX, like the above bridge mode.

**Arduino software**

Follow these few steps to start playing with your EasyVR module and Arduino:

1. Connect the EasyVR module to your Arduino board as outlined before
2. If you want audio output, connect an 8Ω speaker to J2 header
3. Connect the supplied microphone to the MIC (J3) connector
4. Copy the EasyVR library to your Arduino "libraries" folder on your PC
5. Connect your Arduino board to your PC via USB.

![Figure 1 – Installation folder for the EasyVR Arduino library](image-url)
To check everything is working fine:

1. Make sure you activate bridge mode (either manually or automatically) or you use adapter mode
2. Open the EasyVR Commander and connect to the Arduino serial port (see Getting Started)

To download a new sound-table:

1. Power OFF the EasyVR module (for example removing the USB cable)
2. Connect the /XM pin of J4 on the EasyVR module for boot mode (see Flash Update for a possible circuit)
3. Power ON again the EasyVR module and the Arduino board (reconnect the USB cable)
4. Make sure you activate bridge mode (either manually or automatically) or you use adapter mode
5. Open the EasyVR Commander and select the Arduino serial port
6. While disconnected choose “Update Sound Table” from the “Tools” menu (see Using Sound Table)

To test the EasyVR module with your Arduino programming IDE:

1. Make sure you did not activate bridge mode manually
2. Open the example sketch TestEasyVR from your IDE menu “File” > “Examples” > “EasyVR”
3. Upload the sketch and open the “Serial Monitor” window
4. See comments on top of the sketch for usage details

When the EasyVR Commander is connected, you can also generate a template code for Arduino, that will use the provided libraries (see EasyVR Arduino Library Documentation). All you need is to write actions for each recognized command and adapt the code to your needs.
EasyVR on Robonova
With the robot switched off, connect the EasyVR module to the ROBONOVA controller board as in the following diagram. Connect the microphone to the white MIC connector J2.

The EasyVR Commander software can be used to easily connect the PC to the EasyVR module, without the need of additional adapter boards, but simply by using the microcontroller host board with the provided "bridge" program.

To start using the EasyVR Commander, connect the robot to your PC and turn on your ROBONOVA. Select the serial port to use (the same as in RoboBasic Editor) from the toolbar or from the “File” menu, then go with the “Connect” command.

Once connected to the robot, the EasyVR Commander software automatically downloads the RoboBasic “bridge” program to the controller board, if not already present, and pass to its “programming” mode: you can add and train new custom commands or change the language for built-in commands.

The “bridge” program, also has a “test” mode that allows the user to work with the robot and the set of built-in commands the EasyVR module provides: once the bridge program has been downloaded to the robot controller, you can disconnect the EasyVR Commander, detach the serial cable and immediately start using the robot with the built-in vocal commands (see Built-in Command Sets).

For example, you can say "Robot" (the LED will turn on), then after a little pause say "Move" (wait for the LED to blink), then say "Forward": the robot will take a short walk.

The EasyVR Commander can also generate a template RoboBasic code to help you start working with custom commands. Once you have created and trained all your desired commands, you can generate the basic template program by using the icon on the toolbar or the “File” menu.

Then disconnect EasyVR Commander, open the file with the RoboBasic Editor, make the required changes to customize the behavior, and finally download and run it on the ROBONOVA controller.

Have fun!

Please note: the download of a sound table through the ROBONOVA controller board is not supported, due to limitations of this hardware setup. You may use an USB/Serial adapter or another bridge configuration to update the flash memory of the EasyVR module.
EasyVR on Basic Stamp

The EasyVR module can be connected to all Basic Stamp 2 series devices following the connection scheme below. This is supported by the EasyVR Commander software with a special “bridge” code running on the Basic Stamp, which can be downloaded automatically if not present.

The status LED is used to signal that a recognition task is in progress and the application is listening for a voice command. This is optional and can be omitted.

When connected with the EasyVR Commander you can add and remove custom voice commands, as well as train and test them. You can also generate a template PBASIC code to manage voice recognition, that you can easily customize for your own application.

Please note: the download of a sound table through any Basic Stamp 2 controller board is not supported, due to limitations of this hardware setup. You may use an USB/Serial adapter or another suitable configuration to update the flash memory of the EasyVR module.
EasyVR Shield for Arduino

The EasyVR Shield is an Arduino shield integrating the EasyVR module, designed to simplify the EasyVR management for all the Arduino developers.

Technical specifications

Physical dimensions and pin assignment

<table>
<thead>
<tr>
<th>Connector</th>
<th>Number</th>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1, J2</td>
<td></td>
<td></td>
<td></td>
<td>Shield interface, same as on Arduino (Pins 0-1 are in use when J12 is set as UP, PC or HW) (Pins 12-13 are in use when J12 is set as SW)</td>
</tr>
<tr>
<td>J3, J4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J9</td>
<td></td>
<td>LINE OUT</td>
<td>O</td>
<td>3.5mm stereo/mono headphone jack (16Ω - 32Ω headphones)</td>
</tr>
<tr>
<td>J10</td>
<td>1-2</td>
<td>SPEAKER</td>
<td>O</td>
<td>Differential audio output (can directly drive an 8Ω speaker)</td>
</tr>
<tr>
<td>J11</td>
<td>1</td>
<td>MIC_IN</td>
<td>I</td>
<td>Microphone input signal</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>MIC_RET</td>
<td>-</td>
<td>Microphone reference ground</td>
</tr>
<tr>
<td>J13</td>
<td>1</td>
<td>GND</td>
<td>-</td>
<td>Ground reference</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>IO1</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level) (Also used for on-board green LED D6)</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>IO2</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>IO3</td>
<td>I/O</td>
<td>General purpose I/O (3.0 VDC TTL level)</td>
</tr>
</tbody>
</table>

Note: the GPIO (J13.2, J13.3, and J13.4) are at nominal 3.0VDC level. Do not connect 5VDC directly to these pins!
**Jumper settings**

**J12 – Operating mode**

This jumper selects the operating mode of the EasyVR Shield and it can be placed in one of four positions:

- **UP – Flash update mode**
  Use it for firmware updates or to download sound table data to the on-board flash memory from the EasyVR Commander. In this mode, the Arduino controller is held in reset and only the embedded USB/Serial adapter is used. The EasyVR module is set in boot mode.

- **PC – PC connection mode**
  Use it for direct connection with the EasyVR Commander. In this mode, the Arduino controller is held in reset and only the embedded USB/Serial adapter is used.

- **HW – Hardware serial mode**
  Use it for controlling the EasyVR module from your Arduino sketch through the hardware serial port (using pins 0-1).

- **SW – Software serial mode**
  Use it for controlling the EasyVR module from your Arduino sketch through a software serial port (using pins 12-13). You can also connect the EasyVR Commander in this mode, provided that the running sketch implements bridge mode (see libraries).

**LEDs**

A green LED (D6) is connected to IO1 pin and can be controlled by the user’s program to show feedback during recognition tasks, for example. This LED is on by default after reset or power up.

The red LED (D5) lights up when you set the shield to flash update mode (see Jumper settings).

**Quick start for using the Shield**

Follow these few steps to start playing with your EasyVR Shield and Arduino:

1. Insert the EasyVR Shield on top of your Arduino board
2. If you want audio output, either wire an 8Ω speaker into the screw terminals (J10) or connect headphones to the 3.5mm output jack (J9)
3. Connect the supplied microphone to the MIC IN (J11) connector
4. Copy the EasyVR library to your Arduino “libraries” folder on your PC
5. Connect your Arduino board to your PC via USB.

![Figure 2 – Installation folder for the EasyVR Arduino library](Image)
To check everything is working fine:

1. Make sure the jumper (J12) is in the PC position
2. Open the EasyVR Commander and connect to the Arduino serial port (see Getting Started)

To download a new sound-table:

1. Make sure the jumper (J12) is in the UP position
2. Open the EasyVR Commander and select the Arduino serial port
3. While disconnected choose “Update Sound Table” from the “Tools” menu (see Using Sound Table)

To test the Shield with your Arduino programming IDE:

1. Set the jumper (J12) in the SW position
2. Open the example sketch TestEasyVR from your IDE menu “File” > “Examples” > “EasyVR”
3. Upload the sketch and open the “Serial Monitor” window
4. See comments on top of the sketch for usage details

Keep in mind that if you have a “bridge” code running (all examples do) on Arduino, you can connect the EasyVR Commander leaving the jumper in the SW position, just make sure the monitor window is closed.

When the EasyVR Commander is connected, you can also generate a template code for Arduino, that will use the provided libraries (see EasyVR Arduino Library Documentation). All you need is to write actions for each recognized command.
EasyVR Programming

Communication Protocol

Introduction

Communication with the EasyVR module uses a standard UART interface compatible with 3.3-5V TTL/CMOS logical levels, according to the powering voltage VCC. A typical connection to an MCU-based host:

The initial configuration at power on is 9600 baud, 8 bit data, No parity, 1 bit stop. The baud rate can be changed later to operate in the range 9600 - 115200 baud.

The communication protocol only uses printable ASCII characters, which can be divided in two main groups:

- Command and status characters, respectively on the TX and RX lines, chosen among lower-case letters.
- Command arguments or status details, again on the TX and RX lines, spanning the range of capital letters.

Each command sent on the TX line, with zero or more additional argument bytes, receives an answer on the RX line in the form of a status byte followed by zero or more arguments.

There is a minimum delay before each byte sent out from the EasyVR module to the RX line, that is initially set to 20 ms and can be selected later in the ranges 0 - 9 ms, 10 - 90 ms, and 100 ms - 1 s. That accounts for slower or faster host systems and therefore suitable also for software-based serial communication (bit-banging).

Since the EasyVR serial interface also is software-based, a very short delay might be needed before transmitting a character to the module, especially if the host is very fast, to allow the EasyVR to get back listening to a new character.

The communication is host-driven and each byte of the reply to a command has to be acknowledged by the host to receive additional status data, using the space character. The reply is aborted if any other character is received and so there is no need to read all the bytes of a reply if not required.

Invalid combinations of commands or arguments are signaled by a specific status byte, that the host should be prepared to receive if the communication fails. Also a reasonable timeout should be used to recover from unexpected failures.

If the host does not send all the required arguments of a command, the command is ignored by the module, without further notification, and the host can start sending another command.

The module automatically goes to lowest power sleep mode after power on. To initiate communication, send any character to wake-up the module.
Arguments Mapping

Command or status messages sent over the serial link may have one or more numerical arguments in the range -1 to 31, which are encoded using mostly characters in the range of uppercase letters. These are some useful constants to handle arguments easily:

**ARG_MIN**

' @ ' (40h) Minimum argument value (-1)

**ARG_MAX**

' ` ' (60h) Maximum argument value (+31)

**ARG_ZERO**

'A' (41h) Zero argument value (0)

**ARG_ACK**

' ' (20h) Read more status arguments

Having those constants defined in your code can simplify the validity checks and the encoding/decoding process. For example (in pseudo-code):

```
# encode value 5
FIVE = 5 + ARG_ZERO
# decode value 5
FIVE - ARG_ZERO = 5
# validity check
IF ARG < ARG_MIN OR ARG > ARG_MAX THEN ERROR
```

Just to make things clearer, here is a table showing how the argument mapping works:

<table>
<thead>
<tr>
<th>ASCII</th>
<th>'@'</th>
<th>'A'</th>
<th>'B'</th>
<th>'C'</th>
<th>...</th>
<th>'Y'</th>
<th>'Z'</th>
<th>'^'</th>
<th>'['</th>
<th>''</th>
<th>']'</th>
<th>'_'</th>
<th>''</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEX</td>
<td>40</td>
<td>41</td>
<td>42</td>
<td>43</td>
<td>...</td>
<td>59</td>
<td>5A</td>
<td>5B</td>
<td>5C</td>
<td>5D</td>
<td>5E</td>
<td>5F</td>
<td>60</td>
</tr>
<tr>
<td>Value</td>
<td>-1</td>
<td>0</td>
<td>1</td>
<td>2</td>
<td>...</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td>31</td>
</tr>
</tbody>
</table>
**Command Details**

This section describes the format of all the command strings accepted by the module. Please note that numeric arguments of command requests are mapped to upper-case letters (see above section).

### CMD_BREAK

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'b' (62h)</td>
<td>Abort recognition, training or playback in progress if any or do nothing</td>
</tr>
</tbody>
</table>

**Known issues:**

In firmware ID 0, any other character received during recognition will prevent this command from stopping recognition that will continue until timeout or other recognition results.

**Expected replies:** STS_SUCCESS, STS_INTERR

### CMD_SLEEP

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'s' (73h)</td>
<td>Go to the specified power-down mode</td>
</tr>
</tbody>
</table>

**Sleep mode (0-8):**

- 0 = wake on received character only
- 1 = wake on whistle or received character
- 2 = wake on loud sound or received character
- 3-5 = wake on double clap (with varying sensitivity) or received character
- 6-8 = wake on triple clap (with varying sensitivity) or received character

**Expected replies:** STS_SUCCESS, STS_AWAKEN

### CMD_KNOB

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'k' (6Bh)</td>
<td>Set SI knob to specified level</td>
</tr>
</tbody>
</table>

**Confidence threshold level (0-4):**

- 0 = loosest: more valid results
- 2 = typical value (default)
- 4 = tightest: fewer valid results

**Note:** knob is ignored for trigger words

**Expected replies:** STS_SUCCESS

### CMD_LEVEL

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'v' (76h)</td>
<td>Set SD level</td>
</tr>
</tbody>
</table>

**Strictness control setting (1-5):**

- 1 = easy
- 2 = default
- 5 = hard

A higher setting will result in more recognition errors.

**Expected replies:** STS_SUCCESS

### CMD_LANGUAGE

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'l' (6Ch)</td>
<td>Set SI language</td>
</tr>
</tbody>
</table>

**Language:**

- 0 = English
- 1 = Italian
- 2 = Japanese
- 3 = German
- 4 = Spanish
- 5 = French

**Expected replies:** STS_SUCCESS
### **CMD_TIMEOUT**

<table>
<thead>
<tr>
<th>Command (6Fh)</th>
<th>Description</th>
<th>Expected replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>'o'</td>
<td>Set recognition timeout</td>
<td>STS_SUCCESS</td>
</tr>
</tbody>
</table>

**[1]** Timeout (-1 = default, 0 = infinite, 1-31 = seconds)

### **CMD_RECOG_SI**

<table>
<thead>
<tr>
<th>Command (69h)</th>
<th>Description</th>
<th>Expected replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>'i'</td>
<td>Activate SI recognition from specified word set</td>
<td>STS_SIMILAR, STS_TIMEOUT, STS_ERROR</td>
</tr>
</tbody>
</table>

**[1]** Word set index (0-3)

### **CMD_TRAIN_SD**

<table>
<thead>
<tr>
<th>Command (74h)</th>
<th>Description</th>
<th>Expected replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>'t'</td>
<td>Train specified SD/SV command</td>
<td>STS_SUCCESS, STS_RESULT, STS_SIMILAR, STS_TIMEOUT, STS_ERROR</td>
</tr>
</tbody>
</table>

**[1]** Group index (0 = trigger, 1-15 = generic, 16 = password)

**[2]** Command position (0-31)

### **CMD_GROUP_SD**

<table>
<thead>
<tr>
<th>Command (67h)</th>
<th>Description</th>
<th>Expected replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>'g'</td>
<td>Insert new SD/SV command</td>
<td>STS_SUCCESS, STS_OUT_OF_MEM</td>
</tr>
</tbody>
</table>

**[1]** Group index (0 = trigger, 1-15 = generic, 16 = password)

**[2]** Position (0-31)

### **CMD_UNGROUP_SD**

<table>
<thead>
<tr>
<th>Command (75h)</th>
<th>Description</th>
<th>Expected replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>'u'</td>
<td>Remove SD/SV command</td>
<td>STS_SUCCESS</td>
</tr>
</tbody>
</table>

**[1]** Group index (0 = trigger, 1-15 = generic, 16 = password)

**[2]** Position (0-31)

### **CMD_RECOG_SD**

<table>
<thead>
<tr>
<th>Command (64h)</th>
<th>Description</th>
<th>Expected replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>'d'</td>
<td>Activate SD/SV recognition</td>
<td>STS_RESULT, STS_SIMILAR, STS_TIMEOUT, STS_ERROR</td>
</tr>
</tbody>
</table>

**[1]** Group index (0 = trigger, 1-15 = generic, 16 = password)

### **CMD_ERASE_SD**

<table>
<thead>
<tr>
<th>Command (65h)</th>
<th>Description</th>
<th>Expected replies</th>
</tr>
</thead>
<tbody>
<tr>
<td>'e'</td>
<td>Erase training of SD/SV command</td>
<td>STS_SUCCESS</td>
</tr>
</tbody>
</table>

**[1]** Group index (0 = trigger, 1-15 = generic, 16 = password)

**[2]** Command position (0-31)
### CMD_NAME_SD

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>'n' (6Eh)</td>
<td>Label SD/SV command</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
</tr>
<tr>
<td>[1]</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
<td></td>
</tr>
<tr>
<td>[2]</td>
<td>Command position (0-31)</td>
<td></td>
</tr>
<tr>
<td>[3]</td>
<td>Length of label (0-31)</td>
<td></td>
</tr>
<tr>
<td>[4-n]</td>
<td>Text for label (ASCII characters from 'A' to '`)</td>
<td></td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS

### CMD_COUNT_SD

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>'c' (63h)</td>
<td>Request count of SD/SV commands in the specified group</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_COUNT

### CMD_DUMP_SD

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>'p' (70h)</td>
<td>Read SD/SV command data (label and training)</td>
<td>Group index (0 = trigger, 1-15 = generic, 16 = password)</td>
</tr>
<tr>
<td>[2]</td>
<td>Command position (0-31)</td>
<td></td>
</tr>
</tbody>
</table>

**Expected replies:** STS_DATA

### CMD_MASK_SD

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>'m' (6Dh)</td>
<td>Request bit-mask of non-empty groups</td>
<td></td>
</tr>
</tbody>
</table>

**Expected replies:** STS_MASK

### CMD_RESETALL

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>'r' (72h)</td>
<td>Reset all commands and groups</td>
<td></td>
</tr>
<tr>
<td>'R' (52h)</td>
<td>Confirmation character</td>
<td></td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS

### CMD_ID

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>'x' (78h)</td>
<td>Request firmware identification</td>
<td></td>
</tr>
</tbody>
</table>

**Expected replies:** STS_ID

### CMD_DELAY

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>'y' (79h)</td>
<td>Set transmit delay</td>
<td>Time (0-10 = 0-10 ms, 11-19 = 20-100 ms, 20-28 = 200-1000 ms)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS
**CMD_BAUDRATE**

<table>
<thead>
<tr>
<th>'a' (61h)</th>
<th>Set communication baud-rate</th>
</tr>
</thead>
</table>
| [1] | Speed mode:  
  1 = 115200  
  2 = 57600  
  3 = 38400  
  6 = 19200  
  12 = 9600 |

**Expected replies:** STS_SUCCESS

**CMD_QUERY_IO**

<table>
<thead>
<tr>
<th>'q' (71h)</th>
<th>Configure, query or modify general purpose I/O pins</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Pin number (1 = pin IO1, 2 = pin IO2, 3 = pin IO3)</td>
</tr>
</tbody>
</table>
| [2] | Pin mode (0 = output low, 1 = output high, 2 = input*, 3 = input strong**, 4 = input weak***)  
  * High impedance input (no pull-up)  
  **Strong means ~10K internal pull-up  
  ***Weak means ~200K internal pull-up (default after power up) |

**Expected replies:** STS_SUCCESS (mode 0-1), STS_PIN (mode 2-4)

**CMD_PLAY_SX**

<table>
<thead>
<tr>
<th>'w' (77h)</th>
<th>Wave table entry playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-2]</td>
<td>Two 5-bit values that form a 10-bit index to the sound table (index = [1] * 32 + [2])</td>
</tr>
<tr>
<td>[3]</td>
<td>Playback volume (0-31, 0 = min volume, 15 = full scale, 31 = double gain)</td>
</tr>
</tbody>
</table>

**Expected replies:** STS_SUCCESS, STS_ERROR

**CMD_DUMP_SX**

<table>
<thead>
<tr>
<th>'h' (68h)</th>
<th>Read wave table data</th>
</tr>
</thead>
</table>

**Expected replies:** STS_TABLE_SX, STS_OUT_OF_MEM
### Status Details

Replies to commands follow this format. Please note that numeric arguments of status replies are mapped to upper-case letters (see the related section).

#### STS_MASK

<table>
<thead>
<tr>
<th>'k' (6Bh)</th>
<th>Mask of non-empty groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-8]</td>
<td>4-bit values that form 32-bit mask, LSB first</td>
</tr>
</tbody>
</table>

In reply to: CMD_MASK_SD

#### STS_COUNT

<table>
<thead>
<tr>
<th>'c' (63h)</th>
<th>Count of commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Integer (0-31)</td>
</tr>
</tbody>
</table>

In reply to: CMD_COUNT_SD

#### STS_AWAKEN

<table>
<thead>
<tr>
<th>'w' (77h)</th>
<th>Wake-up (back from power-down mode)</th>
</tr>
</thead>
</table>

In reply to: Any character after power on or sleep mode

#### STS_DATA

<table>
<thead>
<tr>
<th>'d' (64h)</th>
<th>Provide command data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Training information (-1=empty, 1-6 = training count, +8 = SD/SV conflict, +16 = SI conflict)</td>
</tr>
</tbody>
</table>

**Known issues:**

In firmware ID 0, command creation/deletion might cause other empty commands training count to change to 7. Treat count values of -1, 0 or 7 as empty training markers. Never train commands more than 2 or 3 times.

<table>
<thead>
<tr>
<th>[2]</th>
<th>Conflicting command position (0-31, only meaningful when trained)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[3]</td>
<td>Length of label (0-31)</td>
</tr>
<tr>
<td>[4-n]</td>
<td>Text of label (ASCII characters from 'A' to `)</td>
</tr>
</tbody>
</table>

In reply to: CMD_DUMP_SD

#### STS_ERROR

<table>
<thead>
<tr>
<th>'e' (65h)</th>
<th>Signal recognition error</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-2]</td>
<td>Two 4-bit values that form 8-bit error code (error = [1] * 16 + [2], see appendix)</td>
</tr>
</tbody>
</table>

In reply to: CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD, CMD_PLAY_SX

#### STS_INVALID

<table>
<thead>
<tr>
<th>'v' (76h)</th>
<th>Invalid command or argument</th>
</tr>
</thead>
</table>

In reply to: Any invalid command or argument

#### STS_TIMEOUT

<table>
<thead>
<tr>
<th>'t' (74h)</th>
<th>Timeout expired</th>
</tr>
</thead>
</table>

In reply to: CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD
### STS_INTERR

<table>
<thead>
<tr>
<th>STS_INTERR</th>
<th>Interrupted recognition</th>
</tr>
</thead>
<tbody>
<tr>
<td>'I' (69h)</td>
<td>In reply to: CMD_BREAK while in training, recognition or playback</td>
</tr>
</tbody>
</table>

### STS_SUCCESS

<table>
<thead>
<tr>
<th>STS_SUCCESS</th>
<th>OK or no errors status</th>
</tr>
</thead>
<tbody>
<tr>
<td>'O' (6Fh)</td>
<td>In reply to: CMD_BREAK, CMD_DELAY, CMD_BAUDRATE, CMD_TIMEOUT, CMD_KNOB, CMD_LEVEL, CMD_LANGUAGE, CMD_SLEEP, CMD_GROUP_SD, CMD_UNGROUP_SD, CMD_ERASE_SD, CMD_NAME_SD, CMD_RESETALL, CMD_QUERY_IO, CMD_PLAY_SX</td>
</tr>
</tbody>
</table>

### STS_RESULT

<table>
<thead>
<tr>
<th>STS_RESULT</th>
<th>Recognized SD/SV command or Training similar to SD/SV command</th>
</tr>
</thead>
<tbody>
<tr>
<td>'R' (72h)</td>
<td>[1] Command position (0-31)</td>
</tr>
<tr>
<td></td>
<td>In reply to: CMD_RECOG_SD, CMD_TRAIN_SD</td>
</tr>
</tbody>
</table>

### STS_SIMILAR

<table>
<thead>
<tr>
<th>STS_SIMILAR</th>
<th>Recognized SI word or Training similar to SI word</th>
</tr>
</thead>
<tbody>
<tr>
<td>'S' (73h)</td>
<td>[1] Word index (0-31)</td>
</tr>
<tr>
<td></td>
<td>In reply to: CMD_RECOG_SI, CMD_RECOG_SD, CMD_TRAIN_SD</td>
</tr>
</tbody>
</table>

### STS_OUT_OF_MEM

<table>
<thead>
<tr>
<th>STS_OUT_OF_MEM</th>
<th>Memory error (no more room for commands or sound table not present)</th>
</tr>
</thead>
<tbody>
<tr>
<td>'M' (6Dh)</td>
<td>In reply to: CMD_GROUP_SD, CMD_DUMP_SX</td>
</tr>
</tbody>
</table>

### STS_ID

<table>
<thead>
<tr>
<th>STS_ID</th>
<th>Provide firmware identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>'X' (78h)</td>
<td>[1] Version identifier (0)</td>
</tr>
<tr>
<td></td>
<td>In reply to: CMD_ID</td>
</tr>
</tbody>
</table>

### STS_PIN

<table>
<thead>
<tr>
<th>STS_PIN</th>
<th>Provide pin input status</th>
</tr>
</thead>
<tbody>
<tr>
<td>'P' (70h)</td>
<td>[1] Logic level (0 = input low, 1 = input high)</td>
</tr>
<tr>
<td></td>
<td>In reply to: CMD_QUERY_IO</td>
</tr>
</tbody>
</table>

### STS_TABLE_SX

<table>
<thead>
<tr>
<th>STS_TABLE_SX</th>
<th>Provide sound table data</th>
</tr>
</thead>
<tbody>
<tr>
<td>'D' (64h)</td>
<td>[1-2] Two 5-bit values that form a 10-bit count of entries in the sound table (count = [1] * 32 + [2])</td>
</tr>
<tr>
<td></td>
<td>[3] Length of table name (0-31)</td>
</tr>
<tr>
<td></td>
<td>[4-n] Text of table name (ASCII characters from 'A' to '')</td>
</tr>
<tr>
<td></td>
<td>In reply to: CMD_DUMP_SX</td>
</tr>
</tbody>
</table>
Communication Examples

These are some examples of actual command and status strings exchanged with the EasyVR module by host programs and the expected program flow with pseudo-code sequences. The pseudo-instruction SEND transmits the specified character to the module, while RECEIVE waits for a reply character (a timeout is not explicitly handled for simple commands, but should be always implemented if possible).

Also, the OK and ERROR routines are not explicitly defined, since they are host and programming language dependent, but appropriate code should be written to handle both conditions. Lines beginning with a # (sharp) character are comments.

Please note that in a real programming language it would be best to define some constants for the command and status characters, as well as for mapping numeric arguments, that would be used throughout the program, to minimize the chance of repetition errors and clarify the meaning of the code.

See the Protocol header file for sample definitions that can be used in a C language environment.

Here below all the characters sent and received are written explicitly in order to clarify the communication protocol detailed in the previous sections.

Recommended wake up procedure

```
# wake up or interrupt recognition or do nothing
# (uses a timeout or max repetition count)
DO
   SEND 'b'
LOOP UNTIL RECEIVE = 'o'
```

Recommended setup procedure

```
# ask firmware id
SEND 'x'
IF NOT RECEIVE = 'x' THEN ERROR

# send ack and read status (expecting id=0)
SEND ' '
id = RECEIVE
IF id = 'A' THEN
   # it's a VRbot
ELSE IF id = 'B' THEN
   # it's an EasyVR
ELSE
   # next generation?
END IF

# set language for SI recognition (Japanese)
SEND 'l'
SEND 'C'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set timeout (5 seconds)
SEND 'o'
SEND 'F'
IF RECEIVE = 'o' THEN OK ELSE ERROR
```
Recognition of a built-in SI command

```plaintext
# start recognition in wordset 1
SEND 'i'
SEND 'B'
# wait for reply:
# (if 5s timeout has been set, wait for max 6s then abort
# otherwise trigger recognition could never end)
result = RECEIVE
IF result = 's' THEN
  # successful recognition, ack and read result
  SEND ' '
  command = RECEIVE - 'A'
  # perform actions according to command
ELSE IF result = 't' THEN
  # timed out, no word spoken
ELSE IF result = 'e' THEN
  # error code, ack and read which one
  SEND ' '
  error = (RECEIVE - 'A') * 16
  SEND ' '
  error = error + (RECEIVE - 'A')
  # perform actions according to error
ELSE
  # invalid request or reply
  ERROR
END IF
```

Adding a new SD command

```plaintext
# insert command 0 in group 3
SEND 'g'
SEND 'D'
SEND 'A'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set command label to “ARDUINO_2009”
SEND 'g'
SEND 'D'
SEND 'A'
SEND 'Q'    # name length (16 characters, digits count twice)
SEND 'A'
SEND 'R'
SEND 'D'
SEND 'U'
SEND 'I'
SEND 'N'
SEND 'O'
SEND ' '
# encode each digit with a ^ prefix
# followed by the digit mapped to upper case letters
SEND '3'
SEND 'C'
SEND '3'
SEND 'A'
SEND 'J'
SEND 'A'
SEND 'J'
SEND 'J'
SEND 'J'
IF RECEIVE = 'o' THEN OK ELSE ERROR
```
Training an SD command

```plaintext
# repeat the whole training procedure twice for best results
# train command 0 in group 3
SEND 't'
SEND 'D'
SEND 'A'
# wait for reply:
# (default timeout is 3s, wait for max 1s more then abort)
result = RECEIVE

IF RECEIVE = 'o' THEN
  # training successful
  OK
ELSE IF result = 'r' THEN
  # training saved, but spoken command is similar to
  # another SD command, read which one
  SEND ' '
  command = RECEIVE - 'A'
  # may notify user and erase training or keep it
ELSE IF result = 's' THEN
  # training saved, but spoken command is similar to
  # another SI command (always trigger, may skip reading)
  SEND ' '
  command = RECEIVE - 'A'
  # may notify user and erase training or keep it
ELSE IF result = 't' THEN
  # timed out, no word spoken or heard
ELSE IF result = 'e' THEN
  # error code, ack and read which one
  SEND ' '
  error = (RECEIVE - 'A') * 16
  SEND ' '
  error = error + (RECEIVE - 'A')
  # perform actions according to error
ELSE
  # invalid request or reply
  ERROR
END IF
```

Recognition of an SD command

```plaintext
# start recognition in group 1
SEND 'd'
SEND 'B'
# wait for reply:
result = RECEIVE

IF result = 'r' THEN
  # successful recognition, ack and read result
  SEND ' '
  command = RECEIVE - 'A'
  # perform actions according to command
ELSE IF result = 't' THEN
  # timed out, no word spoken
ELSE IF result = 'e' THEN
  # error code, ack and read which one
  SEND ' '
  error = (RECEIVE - 'A') * 16
  SEND ' '
  error = error + (RECEIVE - 'A')
  # perform actions according to error
ELSE
  # invalid request or reply
  ERROR
END IF
```
Read used command groups

```c
# request mask of groups in use
SEND 'm'
IF NOT RECEIVE = 'k' THEN ERROR
# read mask to 32 bits variable
# in 8 chunks of 4 bits each
SEND ' '
mask = (RECEIVE - 'A')
SEND ' '
mask = mask + (RECEIVE - 'A') * 2
SEND ' '
mask = mask + (RECEIVE - 'A') * 2
... SEND ' '
mask = mask + (RECEIVE - 'A') * 2^24
```

Read how many commands in a group

```c
# request command count of group 3
SEND 'c'
SEND 'D'
IF NOT RECEIVE = 'c' THEN ERROR
# ack and read count
SEND ' '
count = RECEIVE - 'A'
```

Read a user defined command

```c
# dump command 0 in group 3
SEND 'p'
SEND 'D'
SEND 'A'
IF NOT RECEIVE = 'd' THEN ERROR
# read command data
SEND ' '
training = RECEIVE - 'A'
# extract training count (2 for a completely trained command)
tr_count = training AND 7
# extract flags for conflicts (SD or SI)
tr_flags = training AND 24
# read index of conflicting command (same group) if any
SEND ' '
conflict = RECEIVE - 'A'
# read label length
SEND ' '
length = RECEIVE - 'A'
# read label text
FOR i = 0 TO length - 1
SEND ' '
label[i] = RECEIVE
# decode digits
IF label[i] = '^' THEN
SEND ' '
label[i] = RECEIVE - 'A' + '0'
END IF
NEXT
```
Use general purpose I/O pins

```python
# set IO1 pin to logic low level
SEND 'q'
SEND 'B'
SEND 'A'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set IO2 pin to logic high level
SEND 'q'
SEND 'C'
SEND 'B'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# set IO2 pin as input with strong pull-up and read state
SEND 'q'
SEND 'C'
SEND 'D'
IF NOT RECEIVE = 'p' THEN ERROR

# ack and read logic level
SEND ''
pin_level = RECEIVE - 'A'

# set IO3 pin as high impedance input (reading state is optional)
SEND 'q'
SEND 'D'
SEND 'C'
IF NOT RECEIVE = 'p' THEN ERROR
```

Use custom sound playback

```python
# play a beep at full volume (works with any or no table)
SEND 'w'
SEND 'A'
SEND 'A'
SEND 'P'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# play entry 13 at half volume
SEND 'w'
SEND 'A'
SEND 'N'
SEND 'H'
IF RECEIVE = 'o' THEN OK ELSE ERROR

# play entry 123 (=3*32+26) at max volume
SEND 'w'
SEND 'A' + 3
SEND 'A' + 26
SEND 'A' + 31
IF RECEIVE = 'o' THEN OK ELSE ERROR
```

Read sound table

```python
# dump sound table
SEND 'h'
IF NOT RECEIVE = 'h' THEN ERROR

# read count of entries and name length
SEND ''
count = (RECEIVE - 'A') * 32
SEND ''
count = count + (RECEIVE - 'A')
SEND ''
length = RECEIVE - 'A'

# read name text
FOR i = 0 TO length - 1
    SEND ''
    label[i] = RECEIVE
NEXT
```
## Built-in Command Sets

In the tables below a list of all built-in commands for each supported language, along with group index (trigger or word set), command index and language identifier to use with the communication protocol.

<table>
<thead>
<tr>
<th>Trigger Word Set</th>
<th>Command Index</th>
<th>English (US)</th>
<th>Italian</th>
<th>Japanese (Rōmaji)</th>
<th>German</th>
<th>Spanish</th>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>robot</td>
<td>robot</td>
<td>ロボット robotto</td>
<td>roboter</td>
<td>robot</td>
<td>robot</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>move</td>
<td>vai</td>
<td>進め susu-me</td>
<td>gehe</td>
<td>muévete</td>
<td>bouge</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>turn</td>
<td>gira</td>
<td>曲がれ magare</td>
<td>wende</td>
<td>gira</td>
<td>tourne</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>run</td>
<td>corri</td>
<td>走れ hashire</td>
<td>lauf</td>
<td>corre</td>
<td>cours</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>look</td>
<td>guarda</td>
<td>見ろ miro</td>
<td>schau</td>
<td>mira</td>
<td>regard</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>attack</td>
<td>attacca</td>
<td>攻撃 kougeki</td>
<td>attacke</td>
<td>ataca</td>
<td>attaque</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>stop</td>
<td>fermo</td>
<td>止め susu-me</td>
<td>halt</td>
<td>para</td>
<td>arrête</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>hello</td>
<td>ciao</td>
<td>こんにちは konnichiwa</td>
<td>hallo</td>
<td>hola</td>
<td>salut</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>left</td>
<td>a sinistra</td>
<td>左 hidari</td>
<td>nach links</td>
<td>a la izquierda</td>
<td>à gauche</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>right</td>
<td>a destra</td>
<td>右 migi</td>
<td>nach rechts</td>
<td>a la derecha</td>
<td>à droite</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>up</td>
<td>in alto</td>
<td>上 ue</td>
<td>hinauf</td>
<td>arriba</td>
<td>vers le haut</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>down</td>
<td>in basso</td>
<td>下 shita</td>
<td>hinunter</td>
<td>abajo</td>
<td>vers le bas</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>forward</td>
<td>avanti</td>
<td>前 mae</td>
<td>vorwärts</td>
<td>adelante</td>
<td>en avant</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>backward</td>
<td>indietro</td>
<td>後ろ ushiro</td>
<td>rückwärts</td>
<td>atrás</td>
<td>en arrière</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>zero</td>
<td>zero</td>
<td>ゼロ zero</td>
<td>null</td>
<td>cero</td>
<td>zéro</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>one</td>
<td>uno</td>
<td>一 ichi</td>
<td>eins</td>
<td>uno</td>
<td>un</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>two</td>
<td>due</td>
<td>二 ni</td>
<td>zwei</td>
<td>dos</td>
<td>deux</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>three</td>
<td>tre</td>
<td>三 san</td>
<td>drei</td>
<td>tres</td>
<td>trois</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>four</td>
<td>quattro</td>
<td>四 yon</td>
<td>vier</td>
<td>cuatro</td>
<td>quatre</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>five</td>
<td>cinque</td>
<td>五 go</td>
<td>fünf</td>
<td>cinco</td>
<td>cinq</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>six</td>
<td>sei</td>
<td>六 roku</td>
<td>sechs</td>
<td>seis</td>
<td>six</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>seven</td>
<td>sette</td>
<td>七 nana</td>
<td>sieben</td>
<td>siete</td>
<td>sept</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>eight</td>
<td>otto</td>
<td>八 hachi</td>
<td>acht</td>
<td>ocho</td>
<td>huit</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>nine</td>
<td>nove</td>
<td>九 kyu</td>
<td>neun</td>
<td>nueve</td>
<td>neuf</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>ten</td>
<td>dieci</td>
<td>十 jyuu</td>
<td>zehn</td>
<td>diez</td>
<td>dix</td>
</tr>
</tbody>
</table>
**Error codes**

Below the list of the most useful error codes that may be returned by training or recognizing commands.

<table>
<thead>
<tr>
<th>Code</th>
<th>Code Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>03h</td>
<td>ERR_DATACOL_TOO_NOISY</td>
<td>too noisy</td>
</tr>
<tr>
<td>04h</td>
<td>ERR_DATACOL_TOO_SOFT</td>
<td>spoke too soft</td>
</tr>
<tr>
<td>05h</td>
<td>ERR_DATACOL_TOOLOUD</td>
<td>spoke too loud</td>
</tr>
<tr>
<td>06h</td>
<td>ERR_DATACOL_TOO_SOON</td>
<td>spoke too soon</td>
</tr>
<tr>
<td>07h</td>
<td>ERR_DATACOL_TOO_CHOPPY</td>
<td>too many segments/too complex</td>
</tr>
<tr>
<td>11h</td>
<td>ERR_RECOG_FAIL</td>
<td>recognition failed</td>
</tr>
<tr>
<td>12h</td>
<td>ERR_RECOG_LOW_CONF</td>
<td>recognition result doubtful</td>
</tr>
<tr>
<td>13h</td>
<td>ERR_RECOG_MID_CONF</td>
<td>recognition result maybe</td>
</tr>
<tr>
<td>14h</td>
<td>ERR_RECOG_BAD_TEMPLATE</td>
<td>invalid SD/SV command stored in memory</td>
</tr>
<tr>
<td>17h</td>
<td>ERR_RECOG_DURATION</td>
<td>bad pattern durations</td>
</tr>
<tr>
<td>4Ah</td>
<td>ERR_SYNTH_BAD_VERSION</td>
<td>bad release number in speech file</td>
</tr>
<tr>
<td>4Eh</td>
<td>ERR_SYNTH_BAD_MSG</td>
<td>bad data in speech file or invalid compression</td>
</tr>
<tr>
<td>80h</td>
<td>ERR_NOT_A_WORD</td>
<td>recognized word is not in vocabulary</td>
</tr>
</tbody>
</table>

The first group of codes (03h – 07h) is due to errors in the way of speaking to the EasyVR or disturbances in the acquired audio signal that may depend on the surrounding environment.

The second group (11h – 13h) indicates an insufficient score of the recognized word (from lowest to highest). Acceptance of lower score results may be allowed by lowering the “knob” or “level” settings, respectively for built-in and custom commands (see CMD_KNOB and CMD_LEVEL).

A third group of codes (14h – 17h) reports errors in the stored commands that may be due to memory corruption. We suggest you check power level and connections, then erase all the commands in the faulty group and train them again.

The fourth group (4Ah – 4Eh) deals with errors in the compressed sound data, either because the wrong version of the QuickSynthesis™ tool has been used to generate the sound table or because a not supported compression scheme has been selected (or data is generically corrupt).

The last code (80h) means that a word has been recognized that is not in the specified built-in sets. This is due to how Speaker Independent recognition works and should be ignored.
Protocol header file

This file "protocol.h" can be used with applications written in the C language. You can download a copy from the VeeaR website.

```c
#ifndef PROTOCOL_H
#define PROTOCOL_H

#define CMD_BREAK 'b' // abort recognition/playback or ping
#define CMD_SLEEP 's' // go to power down
#define CMD_KNOB 'k' // set si knob <1>
#define CMD_LEVEL 'v' // set sd level <1>
#define CMD_LANGUAGE 'l' // set si language <1>
#define CMD_TIMEOUT 'o' // set timeout <1>
#define CMD_RECOG_SI 'i' // do si recog from ws <1>
#define CMD_TRAIN_SD 't' // train sd command at group <1> pos <2>
#define CMD_GROUP_SD 'g' // insert new command at group <1> pos <2>
#define CMD_UNGROUP_SD 'u' // remove command at group <1> pos <2>
#define CMD_RECOG_SD 'd' // do sd recog at group <1> (0 = trigger mixed si/sd)
#define CMD_ERASE_SD 'e' // reset command at group <1> pos <2>
#define CMD_NAME_SD 'n' // label command at group <1> pos <2> with length <3> name <4-n>
#define CMD_COUNT_SD 'c' // get command count for group <1>
#define CMD_DUMP_SD 'p' // read command data at group <1> pos <2>
#define CMD_MASK_SD 'm' // get active group mask
#define CMD_RESETALL 'r' // reset all commands and groups
#define CMD_ID 'x' // get version id
#define CMD_DELAY 'y' // set transmit delay <1> (log scale)
#define CMD_BAUDRATE 'a' // set baud rate <1> (bit time, 1=>115200)
#define CMD_QUERY_IO 'q' // configure, read or write I/O pin <1> of type <2>
#define CMD_PLAY_SX 'w' // wave table entry <1-2> (10-bit) playback at volume <3>
#define CMD_DUMP_SX 'h' // dump wave table entries
#define STS_MASK 'k' // mask of active groups <1-8>
#define STS_COUNT 'c' // count of commands <1>
#define STS_AWAKEN 'w' // back from power down mode
#define STS_DATA 'd' // get training <1>, conflict <2>, label <3-35> (counted string)
#define STS_ERROR 'e' // signal error code <1-2>
#define STS_INVALID 'v' // invalid command or argument
#define STS_TIMEOUT 't' // timeout expired
#define STS_INTRERR 'i' // back from aborted recognition (see 'break')
#define STS_SUCCESS 'o' // no errors status
#define STS_RESULT 'r' // recognized sd command <1> - training similar to sd <1>
#define STS_SIMILAR 's' // recognized si <1> (in mixed si/sd) - training similar to si <1>
#define STS_OUT_OF_MEM 'm' // no more available commands (see 'group')
#define STS_ID 'x' // provide version id <1>
#define STS_PIN 'p' // return pin state <1>
#define STS_TABLE_SX 'h' // provide table count <1-2> (10-bit), name <3-35> (counted string)

// protocol arguments are in the range 0x40 (-1) to 0x60 (+31) inclusive
#define ARG_MIN 0x40
#define ARG_MAX 0x60
#define ARG_ZERO 0x41
#define ARG_ACK 0x20 // to read more status arguments

#endif //PROTOCOL_H
```
EasyVR Arduino Library Documentation

EasyVR Class Reference

Public Types

- enum ModuleId { VRBOT, EASYVR }
- enum Language { ENGLISH, ITALIAN, JAPANESE, GERMAN, SPANISH, FRENCH }
- enum Group { TRIGGER, PASSWORD }
- enum Wordset { TRIGGER_SET, ACTION_SET, DIRECTION_SET, NUMBER_SET }
- enum Knob { LOOSER, LOOSE, TYPICAL, STRICT, STRICTER }
- enum Level { EASY, NORMAL, HARD, HARDER, HARDEST }
- enum Baudrate { B115200, B57600, B38400, B19200, B9600 }
- enum WakeMode { WAKE_ON_CHAR, WAKE_ON_WHISTLE, WAKE_ON_LOUDSOUND, WAKE_ON_2CLAPS, WAKE_ON_3CLAPS }
- enum ClapSense { CLAP_SENSE_LOW, CLAP_SENSE_MID, CLAP_SENSE_HIGH }
- enum PinConfig { OUTPUT_LOW, OUTPUT_HIGH, INPUT_HIZ, INPUT_STRONG, INPUT_WEAK }
- enum PinNumber { IO1, IO2, IO3 }
- enum SoundVolume { VOL_MIN, VOL_HALF, VOL_FULL, VOL_DOUBLE }
- enum SoundIndex { BEEP }

Public Member Functions

- EasyVR(Stream &s)
- bool detect()
- bool stop()
- int8_t getID()
- bool setLanguage(int8_t lang)
- bool setTimeout(int8_t seconds)
- bool setKnob(int8_t knob)
- bool setLevel(int8_t level)
- bool setDelay(uint16_t millis)
- bool changeBaudrate(int8_t baud)
- bool sleep(int8_t mode)
- bool addCommand(int8_t group, int8_t index)
- bool removeCommand(int8_t group, int8_t index)
- bool setCommandLabel(int8_t group, int8_t index, const char *name)
- bool eraseCommand(int8_t group, int8_t index)
- bool setGroupMask(uint32_t &mask)
- int8_t getCommandCount(int8_t group)
- bool dumpCommand(int8_t group, int8_t index, char *name, uint8_t &training)
- void trainCommand(int8_t group, int8_t index)
- void recognizeCommand(int8_t group)
- void recognizeWord(int8_t wordset)
- bool hasFinished()
- int8_t getCommand()
- int8_t getWord()
- int16_t getError()
- bool isTimeout()
- bool isConflict()
- bool isMemoryFull()
- bool setPinOutput(int8_t pin, int8_t value)
- int8_t getPinInput(int8_t pin, int8_t config)
- void playSoundAsync(int16_t index, int8_t volume)
- bool playSound(int16_t index, int8_t volume)
- bool dumpSoundTable(char *name, int16_t &count)
- bool resetAll()
Detailed Description
An implementation of the EasyVR communication protocol.

Member Enumeration Documentation

class ModuleId
Module identification number (firmware version)

enum Enumerator:

    VRBOT Identifies a VRbot module
    EASYVR Identifies an EasyVR module

class Language
Language to use for recognition of built-in words

enum Enumerator:

    ENGLISH Uses the US English word sets
    ITALIAN Uses the Italian word sets
    JAPANESE Uses the Japanese word sets
    GERMAN Uses the German word sets
    SPANISH Uses the Spanish word sets
    FRENCH Uses the French word sets

class Group
Special group numbers for recognition of custom commands

enum Enumerator:

    TRIGGER The trigger group (shared with built-in trigger word)
    PASSWORD The password group (uses speaker verification technology)

class Wordset
Index of built-in word sets

enum Enumerator:

    TRIGGER_SET The built-in trigger word set
    ACTION_SET The built-in action word set
    DIRECTION_SET The built-in direction word set
    NUMBER_SET The built-in number word set

class Knob
Confidence thresholds for the knob settings, used for recognition of built-in words (except trigger)

enum Enumerator:

    LOOSER Lowest threshold, most results reported
    LOOSE Lower threshold, more results reported
    TYPICAL Typical threshold (default)
    STRICT Higher threshold, fewer results reported
    STRICTER Highest threshold, fewest results reported

class Level
Strictness values for the level settings, used for recognition of custom commands (except triggers)

enum Enumerator:

    EASY Lowest value, most results reported
NORMAL Typical value (default)
HARD Slightly higher value, fewer results reported
HARDER Higher value, fewer results reported
HARDEST Highest value, fewest results reported

enum Baudrate

Constants to use for baudrate settings

Enumerator:

- B115200 115200 bps
- B57600 57600 bps
- B38400 38400 bps
- B19200 19200 bps
- B9600 9600 bps (default)

enum WakeMode

Constants for choosing wake-up method in sleep mode

Enumerator:

- WAKE_ON_CHAR Wake up on any character received
- WAKE_ON_WHISTLE Wake up on whistle or any character received
- WAKE_ON_LOUDSOUND Wake up on a loud sound or any character received
- WAKE_ON_2CLAPS Wake up on double hands-clap or any character received
- WAKE_ON_3CLAPS Wake up on triple hands-clap or any character received

enum ClapSense

Hands-clap sensitivity for wakeup from sleep mode. Use in combination with WAKE_ON_2CLAPS or WAKE_ON_3CLAPS

Enumerator:

- CLAP_SENSE_LOW Lowest threshold
- CLAP_SENSE_MID Typical threshold
- CLAP_SENSE_HIGH Highest threshold

enum PinConfig

Pin configuration options for the extra I/O connector

Enumerator:

- OUTPUT_LOW Pin is a low output (0V)
- OUTPUT_HIGH Pin is a high output (3V)
- INPUT_HIZ Pin is a high impedance input
- INPUT_STRONG Pin is an input with strong pull-up (~10K)
- INPUT_WEAK Pin is an input with weak pull-up (~200K)

enum PinNumber

Available pin numbers on the extra I/O connector

Enumerator:

- IO1 Pin IO1
- IO2 Pin IO2
- IO3 Pin IO3

enum SoundVolume

Some quick volume settings for the sound playback functions (any value in the range 0-31 can be used)

Enumerator:
VOL_MIN  Lowest volume (almost mute)
VOL_HALF  Half scale volume (softer)
VOL_FULL  Full scale volume (normal)
VOL_DOUBLE Double gain volume (louder)

`enum SoundIndex`

Special sound index values, always available even when no soundtable is present

`Enumerator:`

BEEP  Beep sound

Constructor & Destructor Documentation

`EasyVR (Stream & s)`

Creates an EasyVR object, using a communication object implementing the Stream interface (such as HardwareSerial, or the modified SoftwareSerial and NewSoftSerial).

`Parameters:`

`s` the Stream object to use for communication with the EasyVR module

Member Function Documentation

`bool detect ()`

Detects an EasyVR module, waking it from sleep mode and checking it responds correctly.

`Return values:`

is true if a compatible module has been found

`bool stop ()`

Interrupts pending recognition or playback operations.

`Return values:`

is true if the request is satisfied and the module is back to ready

`int8_t getID ()`

Gets the module identification number (firmware version).

`Return values:`

is one of the values in ModuleId

`bool setLanguage (int8_t lang)`

Sets the language to use for recognition of built-in words.

`Parameters:`

`lang` (0-5) is one of values in Language

`Return values:`

is true if the operation is successful

`bool setTimeout (int8_t seconds)`

Sets the timeout to use for any recognition task.
Parameters:
  seconds (0-31) is the maximum time the module keep listening for a word or a command

Return values:
  is true if the operation is successful

bool setKnob (int8_t knob)
Sets the confidence threshold to use for recognition of built-in words.

Parameters:
  knob (0-4) is one of values in Knob

Return values:
  is true if the operation is successful

bool setLevel (int8_t level)
Sets the strictness level to use for recognition of custom commands.

Parameters:
  level (1-5) is one of values in Level

Return values:
  is true if the operation is successful

bool setDelay (uint16_t millis)
Sets the delay before any reply of the module.

Parameters:
  millis (0-1000) is the delay duration in milliseconds, rounded to 10 units in range 10-100 and to 100 units in range 100-1000.

Return values:
  is true if the operation is successful

bool changeBaudrate (int8_t baud)
Sets the new communication speed. You need to modify the baudrate of the underlying Stream object accordingly, after the function returns successfully.

Parameters:
  baud is one of values in Baudrate

Return values:
  is true if the operation is successful

bool sleep (int8_t mode)
Puts the module in sleep mode.

Parameters:
  mode is one of values in WakeMode, optionally combined with one of the values in ClapSense

Return values:
  is true if the operation is successful

bool addCommand (int8_t group, int8_t index)
Adds a new custom command to a group.
Parameters:

group (0-16) is the target group, or one of the values in Groups
index (0-31) is the index of the command within the selected group

Return values:

is true if the operation is successful

bool removeCommand (int8_t group, int8_t index)

Removes a custom command from a group.

Parameters:

group (0-16) is the target group, or one of the values in Groups
index (0-31) is the index of the command within the selected group

Return values:

is true if the operation is successful

bool setCommandLabel (int8_t group, int8_t index, const char * name)

Sets the name of a custom command.

Parameters:

group (0-16) is the target group, or one of the values in Groups
index (0-31) is the index of the command within the selected group

Return values:

is true if the operation is successful

bool eraseCommand (int8_t group, int8_t index)

Erases the training data of a custom command.

Parameters:

group (0-16) is the target group, or one of the values in Groups
index (0-31) is the index of the command within the selected group

Return values:

is true if the operation is successful

bool getGroupMask (uint32_t & mask)

Gets a bit mask of groups that contain at least one command.

Parameters:

mask is a variable to hold the group mask when the function returns

Return values:

is true if the operation is successful

int8_t getCommandCount (int8_t group)

Gets the number of commands in the specified group.

Parameters:

group (0-16) is the target group, or one of the values in Groups

Return values:

is the command count
```c
bool dumpCommand (int8_t group, int8_t index, char * name, uint8_t & training)

Retrieves the name and training data of a custom command.

Parameters:
  group (0-16) is the target group, or one of the values in Groups
  index (0-31) is the index of the command within the selected group
  name points to an array of at least 32 characters that holds the command label when the function
  returns
  training is a variable that holds the training count when the function returns. Additional information
  about training is available through the functions isConflict() and getWord() or getCommand()

Return values:
  is true if the operation is successful

void trainCommand (int8_t group, int8_t index)

Starts training of a custom command. Results are available after hasFinished() returns true.

Parameters:
  group (0-16) is the target group, or one of the values in Groups
  index (0-31) is the index of the command within the selected group

Note:
  The module is busy until training completes and it cannot accept other commands. You can interrupt
  training with stop().

void recognizeCommand (int8_t group)

Starts recognition of a custom command. Results are available after hasFinished() returns true.

Parameters:
  group (0-16) is the target group, or one of the values in Groups

Note:
  The module is busy until recognition completes and it cannot accept other commands. You can
  interrupt recognition with stop().

void recognizeWord (int8_t wordset)

Starts recognition of a built-in word. Results are available after hasFinished() returns true.

Parameters:
  wordset (0-3) is the target word set, or one of the values in Wordset

Note:
  The module is busy until recognition completes and it cannot accept other commands. You can
  interrupt recognition with stop().

bool hasFinished ()

Polls the status of on-going recognition, training or asynchronous playback tasks.

Return values:
  is true if the operation has completed

int8_t getCommand ()

Gets the recognised command index if any.

Return values:
  (0-31) is the command index if recognition is successful, (-1) if no command has been recognized or
```
an error occurred

int8_t getWord ()

Gets the recognised built-in word index if any.

**Return values:**

(0-31) is the command index if recognition is successful, (-1) if no built-in word has been recognized or an error occurred

int16_t getError ()

Gets the last error code if any.

**Return values:**

(0-255) is the error code, (-1) if no error occurred

bool isTimeout ()

Retrieves the timeout indicator.

**Return values:**

is true if a timeout occurred

bool isConflict ()

Retrieves the conflict indicator.

**Return values:**

is true is a conflict occurred during training. To know what caused the conflict, use `getCommand()` and `getWord()` (only valid for triggers)

bool isMemoryFull ()

Retrieves the memory full indicator (only valid after `addCommand()` returned false).

**Return values:**

is true if a command could not be added because of memory size constraints (up to 32 custom commands can be created)

bool setPinOutput (int8_t pin, int8_t value)

Configures an I/O pin as an output and sets its value

**Parameters:**

pin (1-3) is one of values in `PinNumber`

pin (0-1) is one of the output values in `PinConfig`, or Arduino style HIGH and LOW macros

**Return values:**

is true if the operation is successful

int8_t getPinInput (int8_t pin, int8_t config)

Configures an I/O pin as an input with optional pull-up and return its value

**Parameters:**

pin (1-3) is one of values in `PinNumber`

pin (2-4) is one of the input values in `PinConfig`

**Return values:**

is the value of the pin
**void playSoundAsync (int16_t index, int8_t volume)**

Starts playback of a sound from the sound table. Manually check for completion with `hasFinished()`.

**Parameters:**
- `index` is the index of the target sound in the sound table
- `volume` (0-31) may be one of the values in `SoundVolume`

**Note:**
The module is busy until playback completes and it cannot accept other commands. You can interrupt playback with `stop()`.

**bool playSound (int16_t index, int8_t volume)**

Plays a sound from the sound table and waits for completion

**Parameters:**
- `index` is the index of the target sound in the sound table
- `volume` (0-31) may be one of the values in `SoundVolume`

**Return values:**
- `true` if the operation is successful

**Note:**
To alter the maximum time for the wait, define the `EASYVR_PLAY_TIMEOUT` macro before including the `EasyVR` library.

**bool dumpSoundTable (char *name, int16_t &count)**

Retrieves the name of the sound table and the number of sounds it contains

**Parameters:**
- `name` points to an array of at least 32 characters that holds the sound table label when the function returns
- `count` is a variable that holds the number of sounds when the function returns

**Return values:**
- `true` if the operation is successful

**bool resetAll ()**

Empties internal memory for custom commands and groups.

**Return values:**
- `true` if the operation is successful

**Note:**
It will take about 35 seconds for the whole process to complete and it cannot be interrupted. During this time the module cannot accept any other command. The sound table data is not affected.
EasyVRBridge Class Reference

Public Member Functions

- bool check()
- bool checkEEPROM()
- void loop(uint8_t a_rx, uint8_t a_tx, uint8_t b_rx, uint8_t b_tx)

Detailed Description

An implementation of a software bridge between two series of Rx/Tx pins, that enables routing of the hardware serial port (connected to the PC) to digital I/O pins used as a software serial port (connected to the EasyVR).

Member Function Documentation

bool check()
Tests if bridge mode has been requested

Return values:
- is true if bridge mode should be started

Note:
The EasyVR Commander software can request bridge mode using the Serial port. This method does not require to reserve EEPROM locations.

bool checkEEPROM()
Tests if bridge mode has been requested (legacy method)

Return values:
- is true if bridge mode should be started

Note:
The first two EEPROM locations (bytes 0-1) are used for discovery and request of bridge mode from the EasyVR Commander software. Do not use the same locations for other program data.

void loop(uint8_t a_rx, uint8_t a_tx, uint8_t b_rx, uint8_t b_tx)
Performs bridge mode between port A and B in an endless loop

Parameters:
- a_rx is the Rx pin of port A
- a_tx is the Tx pin of port A
- b_rx is the Rx pin of port B
- b_tx is the Tx pin of port B

Note:
Bridge mode internally connects Rx:A to Tx:B and Rx:B to Tx:A. This is done by reading from a pin and writing to the other in a fast loop, that runs until the microcontroller is reset.
EasyVR Commander

The EasyVR Commander software can be used to easily configure your EasyVR module connected to your PC through an adapter board, or by using the microcontroller host board with the provided “bridge” program (available for ROBONOVA controller board, Arduino 2009/UNO, Parallax Basic Stamp).

You can define groups of commands or passwords and generate a basic code template to handle them. It is required to edit the generated code to implement the application logic, but the template contains all the functions or subroutines to handle the speech recognition tasks.

Getting Started

Connect the adapter board or a microcontroller host board with a running “bridge” program\(^1\) to your PC, and then check that all devices are properly turned on and start the EasyVR Commander. Select the serial port to use from the toolbar or the “File” menu, and then go with the “Connect” command.

There are four kinds of commands in the software (see Figure 3 and Figure 6):

- **Trigger** - is a special group where you have the built-in SI trigger word “Robot” and you may add one user-defined SD trigger word. Trigger words are used to start the recognition process
- **Group** - where you may add user-defined SD commands
- **Password** - a special group for "vocal passwords" (up to five), using Speaker Verification (SV) technology
- **Wordset** - built-in set of SI commands (for instance in Figure 3 above, the Wordset 1 is selected)

\(^1\) On some systems the EasyVR Commander can automatically upload the “bridge” program to the host board once connected. That applies to Robonova controller board and Parallax Basic Stamp.
**Speech Recognition**

The recognition function of the EasyVR works on a single group at a time, so that users need to group together all the commands that they want to be able to use at the same time.

When EasyVR Commander connects to the module, it reads back all the user-defined commands and groups, which are stored into the EasyVR module non-volatile memory.

You can add a new command by first selecting the group in which the command needs to be created and then using the toolbar icons or the “Edit” menu.

A command should be given a label and then it should be trained twice with the user's voice: the user will be guided throughout this process (see Figure 4) when the "Train Command" action is invoked.

![Figure 4 – Guided training dialog](image)

**Note:** after clicking on Phase 1 or Phase 2 buttons, remember to start speaking only when you see this little window:

![Speak now...](image)

If any error happens, command training will be cancelled. Errors may happen when the user's voice is not heard correctly, there is too much background noise or when the second word heard is too different from the first one.

![Figure 5 – Alert dialog in case of conflict](image)

The software will also alert if a command is too similar to an existing one by specifying the index of the conflicting command in the “Conflict” column. For example, in the following Figure 6 the command...
"TEST_CMD_ONE" sounds too similar to "TEST_CMD_ZERO" (i.e. they have been trained with a similar pronunciation).

**Note:** TEST_CMD_ZERO and TEST_CMD_ONE are just examples of labels, you should use label names that reflects the real command that you are going to train.

![EasyVR Commander - v2.2.1](image)

**Figure 6 – Conflicting commands**

The current status is displayed in the EasyVR Commander list view where groups that already contain commands are highlighted in bold.

The selected group of commands can also be tested, by using the icon on the toolbar or the "Tools" menu, to make sure the trained commands can be recognized successfully.

**Note:** If you want to re-train a command you have to erase the previous training first.

**Note:** "Vocal passwords" (group 16) are much more sensitive to environment noise and distance from the microphone: be sure to train and give the password in similar conditions.
Using Sound Tables

The EasyVR can also play one of the sounds or sentences saved on the internal flash memory. A predefined “beep” sound is also always available, even when no sounds have been downloaded to the module.

The custom sounds are organized in a so-called “sound table” that users can prepare and build with the special QuickSynthesis™ tool. Please refer to this application’s own manual for details about the creation of a sound table. Let’s summarise the basic steps here:

- Prepare the audio files you want to include in the sound table in WAV format, uncompressed 16-bit 22050Hz mono. To create the sound files you may use a free software like Audacity for example ([http://audacity.sf.net](http://audacity.sf.net))
- Open Sensory’s QuickSynthesis™ 5 and create a new project, specifying “RSC4 family”
- Add your WAV files and specify one of the supported compression scheme (see table below)
- Optionally add sentences, by combining basic WAV sounds. That allows you to save memory when you have speech audio files, if they share some pieces (like “You said” + “One”, “You said” + “Two”, and so on)
- Build the project with QuickSynthesis™ and use default settings (“Build linkable module”, “Load in CONST space”, “Load above or at: 0”). You will be asked to recompress new or modified sound files, just confirm and proceed
- Now save your project and build it once again, so that the EasyVR Commander will see that your build is up to date.

The audio compression formats supported by the EasyVR module are:

<table>
<thead>
<tr>
<th>Compression Scheme</th>
<th>Available Time (8kHz 15% silence)</th>
<th>Available Time (9.3kHz 15% silence)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SX-2</td>
<td>8.7 minutes</td>
<td>7.5 minutes</td>
</tr>
<tr>
<td>SX-3</td>
<td>7.6 minutes</td>
<td>6.6 minutes</td>
</tr>
<tr>
<td>SX-4</td>
<td>6.8 minutes</td>
<td>5.9 minutes</td>
</tr>
<tr>
<td>SX-5</td>
<td>6.1 minutes</td>
<td>5.2 minutes</td>
</tr>
<tr>
<td>SX-6</td>
<td>5.6 minutes</td>
<td>4.8 minutes</td>
</tr>
<tr>
<td>4-bit ADPCM</td>
<td>87 seconds</td>
<td>N/A</td>
</tr>
<tr>
<td>8-bit PCM</td>
<td>45 seconds</td>
<td>38 seconds</td>
</tr>
</tbody>
</table>

Once the sound table has been created, it can be processed by the EasyVR Commander and downloaded to the module. Note that you must first disconnect from the module and do the steps required to start it in “boot-mode” (see the section Flash Update).

Now the command “Update Sound Table” is enabled, either on the toolbar or the “Tools” menu, and it can be used to start the update process. First you will be prompted to open the QuickSynthesis project file just created and a new sound table will be generated.

**Note:** The project must have been built already with the QuickSynthesis tool, before the sound table generation can be completed successfully. If a recent build is not available you will receive a warning message, the project can be opened in QuickSynthesis again and a fresh build started (make sure the project file has been saved before the build).

Once back in the EasyVR Commander the project can be reloaded by pressing the “Refresh” button. If the process completes successfully, the “Download” button will be enabled and the flash update process can start.
The download process will connect at a higher speed to the EasyVR module, so the “bridge” program running on your host device might not work (in particular Robonova and Basic Stamp cannot be used for this purpose) and you might need a true “serial adapter”.

The full speed used is 230400 bit/s, but the option “Slow transfer” can be used to reduce it to 115200, for better compatibility with slower serial adapters. One adapter that can go to full speed is the SmartVR DevBoard. Otherwise any USB/Serial adapter with TTL/CMOS interface can be used for updating the flash. The EasyVR Shield can be used for the download, provided that the jumper (J12) is in UP position.

After the download completes, a new connection can be established with the EasyVR module (in “normal-mode”) and the new sounds will be displayed by the EasyVR Commander, in the special group “SoundTable” (the last one in the list with a yellow icon).

They can be played back and tested using the “Play Sound” command on the toolbar or in the “Tools” menu.

See also how to do that in your application in the code example Use custom sound playback.

---

2 Arduino UNO (and other boards with USB/Serial adapter based on ATMEGA8U2) need the option “Slow transfers” enabled
How to get support

Please feel free to contact us with any questions, queries or suggestions. If your question is about technical support or troubleshooting for one of our products, we kindly ask you to first check our Forum for a possible solution: http://www.veear.eu

If you cannot find an existing solution on the forum, we strongly recommend posting your support request on the forum for as quick a response as possible. The more detail you provide, the better support we can give.
VeeaR © TIGAL KG, all right reserved.

All VeeaR branded boards and software are manufactured by TIGAL KG. Made in Austria.

TIGAL KG assumes no responsibility for any errors, which may appear in this manual. Furthermore, TIGAL KG reserves the right to alter the hardware, software, and/or specifications detailed herein at any time without notice, and does not make any commitment to update the information contained herein. TIGAL KG products are not authorized for use as critical components in life support devices or systems.